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1 Introduction 

1.1  About HiveMap 

HiveMap is a cutting-edge mapping solution that empowers geoscience professionals to capture 

high-quality data in the field or office and relay this info into important geological and 

geotechnical modelling and analysis.  

HiveMap was developed by SRK Consulting to support improved mapping and data 

interpretation of remotely collected rock exposure data. This was motivated by a desire to 

increase data availability to support improved geological interpretations and products for their 

clients. SRK remains intimately involved in the direction of HiveMap, with a team of experienced 

industry professionals supporting its development and engagement with users. 

● Precise Mapping 

○ HiveMap delivers high-resolution, precise geological mapping that ensures 

reliable data for better decision-making. 

● Easily Integrates 

○ Integrate HiveMap with existing datasets and downstream modelling packages 

for a streamlined workflow. 

● Collaborate in Real-Time 

○ Foster real-time, safe, cross-functional collaboration among geologists and 

engineers, regardless of location. 

● Quick to Generate 

○ Capture high-confidence geological observations that are quickly and 

immediately usable for analysis, interpretation, and discussion. 

1.2  What Is Mapping?  

Mapping is the process of looking at the rocks and recording what we see. Depending on our 

technical discipline, what we record, and the level of detail achieved can vary significantly. It is 

also important to understand that mapping involves recording the location of geological features, 

their orientations, and their attributes. These fundamental observations must be recorded 

properly and consistently to support downstream analysis and modeling work.  

To learn more about HiveMap, check out our blog posts: https://hivemap3d.com/blog/  

  

https://www.srk.com/en/contact-us/vancouver
https://hivemap3d.com/blog/
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1.3  Software Installation  

There are two ways to download HiveMap: 

 

1. Using the Microsoft Store app 

2. Direct download provided by the HiveMap Team (to be used if there are company IT 

restrictions on use of Microsoft Store). 

1.4  Microsoft Store 

To download HiveMap, install the program from the Microsoft store & follow the install 

instructions: https://apps.microsoft.com/detail/9mvg8cv6n1q4 

Microsoft store download link. 

 

Click Download, and if prompted, click Open Microsoft Store to get to the download page. 

 

 

https://apps.microsoft.com/detail/9mvg8cv6n1q4
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Click on Get from the Microsoft store pop up. 

 

HiveMap will begin to download. A desktop notification will pop up once installation is 

completed. 
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1.5  Direct Download 

If there are any issues with the system installation through Microsoft Store, please submit an IT 

Support Request Form.  Help Desk will follow up and provide a zipped folder for direct download 

of the software. 

2  Quick Start Guide 

In this section an overview of HiveMap features are outlined in a tutorial format. See User Guide 

for more information (Section 3.0).  

2.1 License Registration 

Once HiveMap has been installed, open the software to register the program license. Take the 
following steps: 

 

Step 2.1-1:Click Help in the navigation bar at the top of the screen. Choose the 

‘License’ button. 

Step 2.1-2:On the License popup window, click on the Request Registration button 

which will open the license registration form. 

Help Desk will process your licensing request once the form is received.  

Users will receive an email from Help Desk once the license is confirmed set up and 

active.  

To activate the user license, restart HiveMap. 

 

 

 

 

 

Step 2.1-1:Click Help in the navigation bar at the top of the screen. Choose the ‘License’ button. 

 

 

 

https://hivemap3dsa.ebforms.com/6343937109524480
https://hivemap3dsa.ebforms.com/6343937109524480
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Step 2.1-2:On the License popup window, click on the Request Registration button which will 

open the license registration form. 

 
 
 
 
 
 

2.2  System Set Up  

Before you can begin creating projects in HiveMap, the system settings need to be configured 

with a Username and a file path location for the HiveMap main folder, where all project files will 

be saved and accessed from. 

Step 2.2-1: To set up HiveMap, go to Settings (top right corner, gear symbol) and 

update the system settings.  

Step 2.2-2: The username and the main file location should then be updated. 

Step 2.2-3: To update the main folder location, click on Select Main Folder. 

Step 2.2-4: Once the username and main folder path location are updated, click Apply & 

Save Settings.  
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Step 2.2-1: To set up HiveMap, go to Settings (top right corner, gear symbol) and update the 
system settings. 

 

Step 2.2-2: The username and the main file location should then be updated.  

 
 

Step 2.2-3: To update the main folder location, click on Select Main Folder. 

 

 

Step 2.2-4: Once the username and main folder path location are updated, click Apply & Save 
Settings. 
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2.3  User Interface 

The HiveMap main window has 3 main areas: ribbon menu (red), view menu (blue), and 

workspace (green). 

The ribbon menu is located on the top of the HiveMap window. It contains tabs which 

groups tools and options. Mapping (section 3.4), Kinematic (section 3.5), Sampling 

(section 3.6), Tools (section 3.7), Networking (section 3.8) and Help (section 3.9) tabs 

can be accessed from here. Ribbon menu can be hidden with Hide/Unhide ribbon 

button. 

View menu is located left side of the window. View menu is used to adjust the camera of 

the 3D View and display settings of the objects in the 3D View (section 3.3). 

Workspace has dockable panels that can be dragged interactively around the screen to 

make them float over any location, and dock back to panels. Below shows the default 

layout of the workspace. 
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There are 4 different default layouts, which include Default, Geotech, Geology, and Tablet. 
Users can switch between these layouts or create their own layout and save it. To save a 
custom layout, enter a name and click the Save button. To delete a custom layout, select the X 
beside the specific layout and it will be deleted. 
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2.4  Adjusting panel layout 

All panel sizes can be adjusted in the workspace. 

Move your cursor to the edge of the panel you want to resize. When the cursor changes to a 

double-sided arrow, press, and hold the left mouse button. Drag the mouse to adjust the panel 

to your desired size. 

 

A panel can be moved out from its docked position and become a floating panel or can be 

docked to a new position. 

Step 1: Move your cursor to the title of the panel you want to move.  

Step 2: Press and hold the left mouse button.  

Step 3: Drag the mouse to move the panel. A shade of a panel will be displayed.  

Step 4: Release the mouse button and the panel will appear where the panel shade was 

displayed. 
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While dragging the panel, if the cursor gets close to a panel border in the workspace, the panel 

shade will appear docked to that border. 
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If it is not close to any panel border, the shade will appear as a floating panel. 

 

If the mouse cursor gets over a title bar of another panel, it will be attached as a tab to the 

panel. 
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To move the floating panel, move your mouse cursor to the title bar, but not to the title. Press 

and hold the left mouse button. Drag the mouse to move the panel.
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2.5  Importing First Project 

Users can access the HiveMap training data files on the website from the resources page: 

hivemap3d.com/resources.  

The HiveMap Training Data.zip file folder contains 3 zipped sub-folders as follows: 

● HiveMap_JointSetAnalysis 

● HiveMap_Training_Initial 

● HiveMap_Training_Interpreted 

 

Download the training data files zip folder, then extract all the files.  There will be 3 zipped sub-

folders within.  

Step 2.5-1: Extract the files for each zipped sub folder. 

Step 2.5-2: Copy these folders to the HiveMap main folder. 

Step 2.5-3: Go to Projects tab. 

Step 2.5-4: If the training data set is not visible on the Projects list, click the Refresh 

button. 

Step 2.5-5: On the project list click “HiveMap_Training_Initial” project. All the data of this 

project will be listed in the Explorer panel. This project has 12 mesh files which are listed 

under the Mesh Files branch. 

Step 2.5-6: Right click the “Mesh Files” branch which will select all the mesh files and 

display right click menu. Click the Load button. 

Step 2.5-7: The loading status for each file will appear beside each file name. 

Step 2.5-8: Once all the meshes have been loaded, the 3D View panel will automatically 

zoom in on the loaded mesh files.  

 

 

 

 

 

 

 

 

 

 

 

 

 

http://hivemap3d.com/resources
https://support.microsoft.com/en-us/windows/zip-and-unzip-files-8d28fa72-f2f9-712f-67df-f80cf89fd4e5
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Step 2.5-1: Extract the files for each zipped sub folder. 

 
 

               

Step 2.5-2: Copy these folders to the HiveMap main folder. 
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Step 2.5-3: Go to Projects tab. 

 
 

 

Step 2.5-4: If the training data set is not visible on the Projects list, click the Refresh button. 
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Step 2.5-5: On the project list click “HiveMap_Training_Initial” project. All the data of this project 
will be listed in the Explorer panel. This project has 12 mesh files which are listed under the 
Mesh Files branch. 

 
 

Step 2.5-6: Right click the “Mesh Files” branch which will select all the mesh files and display 
right click menu. Click the Load button. 
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Step 2.5-7: The loading status for each file will appear beside each file name. 

 
 

 

Step 2.5-8: Once all the meshes have been loaded, the 3D View panel will automatically zoom 

in on the loaded mesh files. 
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2.6  Controls 

To interact with the meshes: 

• Use right mouse button to rotate the mesh. 

• Use the scroll wheel on the mouse to zoom in and out.  

• Use the middle mouse button (usually scroll wheel) to pan the mesh. 

2.6.1  Hotkeys and shortcuts 

A list of hotkeys and shortcuts for the software are included in the Table below. 

 

Tracing 

Enter 
or 

Right Click + Left Click 

Stops the tracing and starts tracing with 
the same structure. 

Shift + Enter 
or 

Shift + Right Click + Left Click 
Stops tracing 

Backspace Undo last node 

Tracing menu 
Esc Close trace editing menu without saving 

Shift + Delete Delete the trace and close the menu 

Orientation 
measurement 

Enter 
or 

Right Click + Left Click 

Create disc (If there is at least 3 
sampling points) 

Backspace Undo last sampling point 

Delete Delete selected disc 

Mesh colours 

1 Texture 

2 Inverse colour 

3 Vertices colour 

4 Shade 

5 Wireframe 

6 Orientation 

7 Slope 

8 Aspect 

9 Elevation 

Change view 
Numpad 0 

Switch between perspective and 
orthographic projection 

Numpad 5 Look down 

Numpad 2 Look south 

Numpad 6 Look west 

Numpad 8 Look north 

Numpad 4 Look east 
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2.7  Mapping Structures 

Step 2.7-1: By using your mouse find a geological structure such as fault to trace on the 

mesh. 

Step 2.7-2: Go to the Mapping tab on the ribbon and click on the Draw button on the 

Tracing group. 

Step 2.7-3: A drop-down menu is displayed with the list of structures. Select one of these 

structures. 

Step 2.7-4: Use your left mouse button to start tracing the structure on the mesh. You can 

use single clicks or hold down the left mouse button. 

Step 2.7-5: After finishing tracing click on the Stop button to end the process. 

Step 2.7-6: The new trace file is displayed on the Explorer panel under the Traces 

branch. 

Step 2.7-7: To edit the trace file, left click the trace on the mesh. Alternatively, right click 

the trace on the Explorer panel and then the Edit Trace on the Right Click menu. 

Step 2.7-8: The Trace Menu is displayed, and the nodes of the trace polyline/polygon 

becomes visible. 

Step 2.7-9: Click the Add Point button and then click the trace line. 

Step 2.7-10: A new node will be added where the line is clicked. 

Step 2.7-11: Click one of the white nodes. The node will become red, and on the menu 

the Delete Point button will become visible. Click this button to delete the selected red 

node. 

Step 2.7-12: Click the mesh and the red node will move to the clicked position on the 

mesh. 

Step 2.7-13: Click the first or last node of the trace, which is coloured purple. The node 

will become red, and on the menu the Delete Point button and Continue Tracing button 

will become visible. Click Continue Tracing. This will close Trace Menu and hide the 

nodes and tracing will continue from the selected node. 

Step 2.7-14: On the Trace Menu click the Calculate DD/Dip of Trace. A disc with the 

orientation of the structure will be created. 

Step 2.7-15: To save the changes click X on the top right of the Trace Menu. A menu will 

be displayed. 
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Step 2.7-1: By using your mouse find a geological structure such as fault to trace on the mesh. 

 

Step 2.7-2: Go to the Mapping tab on the ribbon and click on the Draw button on the Tracing 

group. 
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Step 2.7-3: A drop-down menu is displayed with the list of structures. Select one of these 
structures. 

 
 

Step 2.7-4: Use your left mouse button to start tracing the structure on the mesh. You can use 

single clicks or hold down the left mouse button.  
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Step 2.7-5: After finishing tracing click on the Stop button to end the process. 

 
 

Step 2.7-6: The new trace file is displayed on the Explorer panel under the Traces branch. 
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Step 2.7-7: To edit the trace file, left click the trace on the mesh. Alternatively, right click the 
trace on the Explorer panel and then the Edit Trace on the Right Click menu. 

 
 

Step 2.7-8: The Trace Menu is displayed, and the nodes of the trace polyline/polygon becomes 

visible. 
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Step 2.7-9: Click the Add Point button and then click the trace line. 

 
 

 

Step 2.7-10: A new node will be added where the line is clicked. 
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Step 2.7-11: Click one of the white nodes. The node will become red, and on the menu the 
Delete Point button will become visible. Click this button to delete the selected red node. 

 
 

Step 2.7-12: Click the mesh and the red node will move to the clicked position on the mesh. 

 
 

 

 

 

 

 

 

 

 

 



 

 
Table of Contents 

 
HiveMap User Manual (v2 20250424)                                                                                            Page 29 of 160 

Step 2.7-13: Click the first or last node of the trace, which is coloured purple. The node will 

become red, and on the menu the Delete Point button and Continue Tracing button will become 

visible. Click Continue Tracing. This will close Trace Menu and hide the nodes and tracing will 

continue from the selected node. 

 

 
 

Step 2.7-14: On the Trace Menu click the Calculate DD/Dip of Trace. A disc with the orientation 
of the structure will be created. 
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Step 2.7-15: To save the changes click X on the top right of the Trace Menu. A menu will be 
displayed. 
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2.8  Joint Mapping 

Step 2.8-1 Go to the Mapping tab on the ribbon and click the Measure button on the 

Orientation Measurement group. 

Step 2.8-2: Find a joint surface and start placing sampling points on it with your left 

mouse button. After placing a number of points, a disc will be created. A best fitting plane 

is calculated to find the orientation of the disc. Disc location and size is determined by the 

2 furthest apart points. 

Step 2.8-3: Number of points can be adjusted by using the Points slider. Increasing the 

number of sampling points will give more accurate orientation measurement. 

Step 2.8-4: Continue mapping other joints. 

 

• While placing sampling points you can press the Backspace key or click the 

Undo button to undo the last sampling point. 

• If you have flat facets to map, you can adjust the point slider to minimum and 

create discs quickly by just placing 3 points for each of them. 

• Alternatively, you can keep the Points slider at maximum and press the enter key 

to create discs by using variable number of points for each joint. If you have 

facets and traces with rough, wavey surfaces you need to increase the number of 

sampling points to get the correct average orientation of the joint. 

 

Step 2.8-5: After finishing mapping click the Stop button. 

 

Disc data will be saved to OrientationData.csv file. If there is an unsaved data a * sign is 

displayed next to the file name in the explorer bar. Clicking the Save or Stop button saves 

data to the file and removes the * sign. 
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Step 2.8-1 Go to the Mapping tab on the ribbon and click the Measure button on the Orientation 

Measurement group. 

 
 

Step 2.8-2: Find a joint surface and start placing sampling points on it with your left mouse 

button. After placing a number of points, a disc will be created. A best fitting plane is calculated 

to find the orientation of the disc. Disc location and size is determined by the 2 furthest apart 

points. 
 

 

Step 2.8-3: Number of points can be adjusted by using the Points slider. Increasing the number 

of sampling points will give more accurate orientation measurement. 
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Step 2.8-4: Continue mapping other joints.  

• While placing sampling points you can press the Backspace key or click the 

Undo button to undo the last sampling point. 

• If you have flat facets to map, you can adjust the point slider to minimum and 

create discs quickly by just placing 3 points for each of them. 

• Alternatively, you can keep the Points slider at maximum and press the enter key 

to create discs by using variable number of points for each joint. If you have 

facets and traces with rough, wavey surfaces you need to increase the number of 

sampling points to get the correct average orientation of the joint. 

 

 
 

 

Step 2.8-5: After finishing mapping click the Stop button. 

Disc data will be saved to OrientationData.csv file. If there is an unsaved data a * sign is 

displayed next to the file name in the explorer bar. Clicking the Save or Stop button saves data 

to the file and removes the * sign. 
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2.9  Joint Set Analysis 

Step 2.9-1:Joint set analyses can be undertaken using the Joint Sets tab in the user interface. 

Step 2.9-2: Adjust the Fuzziness slider to 0.70 and click the Find Joint Sets button. This 

separates joints which are away from the joint set centers and categorizes them as random 

joints. 

Step 2.9-3: Increase the number of joint sets to 4 and run the algorithm again. This splits Joint 

Set 2 and some of the joints from this set become members of Joint Set 4. 

Step 2.9-4: By following this process, adjusting the number of joint sets and fuzziness 

parameter, users can determine the joint sets with the help of this algorithm. 

Step 2.9-5:To manually determine the joint sets, check the Manual box. Click the JS#1 button. 

This will open Joint Set 1 menu. Click the Select the Joint Set button on the Stereonet. Change 

the Dip Direction Deviation and Dip Deviation values on the form. Use your left mouse to 

change the location of the Joint Set 1 window on the Stereonet. 

Step 2.9-6: Click X on the top right corner of the menu and click Save changes and close 

button. Click X on the top right corner of the menu and click Save changes and close button. 

Step 2.9-7: Click the Assign Joints to Joint Sets button. All the joints inside Joint Set 1 window 

will be assigned to Joint Set 1.: Click the Assign Joints to Joint Sets button. All the joints inside 

Joint Set 1 window will be assigned to Joint Set 1. 
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Step 2.9-1:  

Joint set analyses can be undertaken using the Joint Sets tab in the user interface. 

• The pole of each joint is displayed on the stereonet. From the rock face and the 

stereonet we can interpret that there are 3 or 4 joint sets. 

• In the Joint Sets panel enter 3 to the Number of Joint Sets box. Then click the Find Joint 

Sets button. 

• The algorithm separates joints into 3 sets and colourizes each joint pole on the stereonet 

and the disc on the 3D View in their joint set colour. Also, the triangles on the mesh are 

colourized if they have the same orientation as the joint sets. 
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Step 2.9-2: Adjust the Fuzziness slider to 0.70 and click the Find Joint Sets button. This 

separates joints which are away from the joint set centers and categorizes them as random 

joints. 
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Step 2.9-3: Increase the number of joint sets to 4 and run the algorithm again. This splits Joint 

Set 2 and some of the joints from this set become members of Joint Set 4. 

 
 

 

 

 

 

 

 

 

 

 

 

 



 

 
Table of Contents 

 
HiveMap User Manual (v2 20250424)                                                                                            Page 38 of 160 

Step 2.9-4: By following this process, adjusting the number of joint sets and fuzziness 

parameter, users can determine the joint sets with the help of this algorithm.  

 
 

Step 2.9-5: To manually determine the joint sets, check the Manual box. Click the JS#1 button. 

This will open Joint Set 1 menu. Click the Select the Joint Set on Stereonet. Change the Dip 

Direction Deviation and Dip Deviation values on the form. Use your left mouse to change the 

location of the Joint Set 1 window on the Stereonet. 
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Step 2.9-6: Click X on the top right corner of the menu and click Save changes and close 

button. 

 
 

 

Step 2.9-7: Click the Assign Joints to Joint Sets button. All the joints inside Joint Set 1 window 

will be assigned to Joint Set 1. 
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Step 2.9-8: Repeat this process for the other joint sets. 

 
 

 

 

2.10  Exporting Data 

2.10.1 Folder Structure 

2.10.2  Joint Mapping Data 

Run Windows File Explorer and go to the main HiveMap folder. Open the project folder 

“HiveMap_Training_Initial”. Then go to OrientationData folder which has OrientationData.csv 

file. 

This file contains all the data which is captured with the Orientation measurement tool. 

 



 

 
Table of Contents 

 
HiveMap User Manual (v2 20250424)                                                                                            Page 42 of 160 

 
 

 

 
 

2.10.3 Tracing Data 

Step 2.10-1: Go to the Tools menu. Click Export Traces as .dxf Files button. Click Export 

button. This will export polyline/polygon of the traces to .dxf files.  

Step 2.10-2: Click the Export Trace Discs button.  
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Step 2.10-1: Go to the Tools menu. Click Export Traces as .dxf Files button. Click Export 

button. This will export polyline/polygon of the traces to .dxf files. 

 

  

  
 

These .dxf files can be found in the ExportedTraceData folder of the project folder. 
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Step 2.10-2: Click the Export Trace Discs button. 

 
 

This will create the TraceOrientationData.csv in the ExportedTraceData folder of the project. 

 
This file has all the discs from the traces. 

 

3  User Guide 

3.1 Projects 

Step  3.1-1: Projects are managed in the Projects panel. If the projects panel is not visible click 

the File button on the ribbon or click title of the Projects panel.: Projects are managed in the 
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Projects panel. If the projects panel is not visible click the File button on the ribbon or click title 

of the Projects panel. 

Step  3.1-2: The last 4 projects that are opened in HiveMap are listed on the top of the panel as 

buttons. Left clicking these buttons will load that project. The last 4 projects that are opened in 

HiveMap are listed on the top of the panel as buttons. Left clicking these buttons will load that 

project. 

project. All projects are listed in the Projects list. In this list are the subfolders which are in the 

HiveMap main folder (Section 2.2). Left clicking these buttons will load that project. 

list. By using A>Z or Date buttons the list can be sorted in alphabetical order or according to 

project’s last edit date. If there are new subfolders in the main folder, click the circular arrow 

button to update the list. 

Project. Create a new project by entering the New Project name and selecting Create Project. 

This will prompt the display view to the 3D View. 

Step  3.1-1: Projects are managed in the Projects panel. If the projects panel is not visible click 

the File button on the ribbon or click title of the Projects panel. 

 
 

 

Step  3.1-2: The last 4 projects that are opened in HiveMap are listed on the top of the panel as 

buttons. Left clicking these buttons will load that project. 
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Step  3.1-3: All projects are listed in the Projects list. In this list are the subfolders which are in 
the HiveMap main folder (Section 2.2). Left clicking these buttons will load that project. 

 
 

 

 

Step  3.1-4: By using A>Z or Date buttons the list can be sorted in alphabetical order or 

according to project’s last edit date. If there are new subfolders in the main folder, click the 

circular arrow button to update the list. 
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Step  3.1-5: Create a new project by entering the New Project name and selecting Create 

Project. 

                

This will prompt the display view to the 3D View. 

 
 

 

 

3.2  Project Explorer and Data 

 

Error! Reference source not found.The explorer panel displays all the imported and created data 

for the projects, with each data type organized under its own branch. These branches include 

Mesh files (link to section), Traces (link to Mapping section), Sampling (link to Sampling 

section), Cells (link), Discs (link), Drillholes (link), and Raster files (link). 

Step 3.2-1: Select All selects all the items in the Explorer. Select All selects all the items in the 

Explorer. 

Step 3.2-2: Left or right clicking a branch selects the items that belongs to that branch. By using 

the Ctrl and Shift Keys with left click, multiple items can be selected. 

 

 

Step  3.2-1:The explorer panel displays all the imported and created data for the projects, with 

each data type organized under its own branch. These branches include: Mesh files , Traces , 

Sampling , Cells , Discs, Drillholes, and Raster files. 
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Right clicking the Explorer panel will display the right click menu. This menu will change 

depending on what kind of item is clicked. 

In an empty area, the right click menu will display Refresh and Select All. Refresh recreates the 

project explorer list. 

If there is a change in the project folder such as removed or added files, that change will be 

seen in the Explorer after Refresh. 

Step 3.2-1: Select All selects all the items in the Explorer. 

 

Step 3.2-2: Left or right clicking a branch selects the items that belongs to that branch. 
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By using the Ctrl and Shift Keys with left click, multiple items can be selected.

 

 

3.2.1  Training Data Files 

Users can access HiveMap training data files on the website Resources page: 

hivemap3d.com/resources  

The HiveMap Training Data.zip file folder contains 3 zipped sub-folders as follows: 

● HiveMap_JointSetAnalysis 

● HiveMap_Training_Initial 

● HiveMap_Training_Interpreted 

 

 

Error! Reference source not found.  

Error! Reference source not found. Extract the files for each zipped sub folder. 

 

These files will be used during HiveMap system training when a project is created, and to demo 

other system functions that are being reviewed during HiveMap training. 

 

 

http://hivemap3d.com/resources
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3.2.2 Mesh Files 

 

HiveMap works with textured mesh files which are in .obj file format. The file formats are as 

follows: 

• .obj files are created with 2 more files which are .mtl and .jpg files 

• .obj files have the geometry information such as triangles, vertices and vertex normals 

• .mtl files are text files referenced by the .obj file, which have the list of texture files 

• .jpg files are texture files. There can be more than 1 file. Textures are limited to 16384 x 

16384 pixels. 

 

Step 3.2-6: After creating a new project, to import mesh files, from within the Explorer panel 

right click over the Mesh Files branch and select Import.  

Step 3.2-7: The File Explorer window will pop up. Find and select the mesh files (.obj) and side 

files (.mtl, .jpg). To multiselect more than one file use the Ctrl or Shift keys.  

Loaded meshes will appear in blue in the Explorer panel. When you right-click on a mesh file, 

the context menu will show options to Zoom, Hide, and Unhide.  

 

 

 

 

 

 

 

 

 

 

Step 8: Zoom will zoom to the selected mesh. 

Step 3.2-9: Hide and Unhide will hide or unhide the selected meshes. Hidden meshes will be 

displayed in a grayed-out appearance. 

Step 3.2-: Left click on a mesh to view its properties in the Properties panel. From there, you 

can hide or unhide the mesh, adjust its brightness and opacity, and change its color. Please 

note that these changes will be reset after reloading the meshes. 

To change the mesh colour, go to the View menu and select either "Texture" or "Shade" from 

the attribute map list. 

Step 3.2-31: Left click the mesh. 

On the properties tab click Change Mesh Colour button. A menu with colour options will pop up. 

Click the colour that you want. 
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Step 3.2-6: After creating a new project, to import mesh files, from within the Explorer panel 

right click over the Mesh Files branch and select Import. 

 
 

Step 3.2-7: The File Explorer window will pop up. Find and select the mesh files (.obj) and side 

files (.mtl, .jpg). To multiselect more than one file use the Ctrl or Shift keys. 

The imported files will be listed in Explorer. Right click the mesh files and select Load to display 

the meshes in 3D View. 
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Loaded meshes will appear in blue in the Explorer panel. When you right-click on a mesh file, 
the context menu will show options to Zoom, Hide, and Unhide. 
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Step 3.2-8: Zoom will zoom to the selected mesh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3.2-9: Hide and Unhide will hide or unhide the selected meshes. Hidden meshes will be 

displayed in a grayed-out appearance. 

 
 

Step 3.2-10: Left click on a mesh to view its properties in the Properties panel. From there, you 

can hide or unhide the mesh, adjust its brightness and opacity, and change its color. Please 

note that these changes will be reset after reloading the meshes. 

To change the mesh colour, go to the View menu and select either "Texture" or "Shade" from 

the attribute map list. 
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Step 3.2-31: Left click the mesh. 

On the properties tab click Change Mesh Colour button. A menu with colour options will pop up. 

Click the colour that you want. 
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3.2.3  Drill Holes 

 

Step 3.2-42: To import drill holes data, go to Explorer panel and right click Drillholes branch and 

select Import.To import drill holes data, go to Explorer panel and right click on the Drillholes 

branch and select Import. 

Step 3.2-53: The following Add Drill Holes pop-up menu will appear.  Click the folder icon next 

to Collar File.  

Step 3.2-64: Select the collar file, which is in .csv file format. 

Step 3.2-65: The first 5 rows of the file are listed. Select the correct matching columns for the 

Hole ID, X, Y, Z and depth parameters of the collar data. 

Step : Repeat the same process for the survey file. Select the correct matching columns for the 

Hole ID, Depth, Dip and Azimuth parameters of survey data. 

You can have more than one interval file. Click the plus and minus icons to adjust the number of 

interval files. 

Step 3.2-97: Click the folder icon next to Interval Files to select the interval file. Select the 

correct matching columns for the Hole ID, From and To parameters of the interval data. Select 

“Value” for the columns that you want to import. If “Ignore” is selected for a column that column 

will not be imported. 

Step 3.2-108: Once the collar, survey and interval files are added, click the Add DH to Project 

button. 

Step 3.2-119: Drillholes will appear in the Explorer panel under the Drillholes branch. Right click 

the Drillholes and select the Drill Hole Colourmaps. 

Step 3.2-20: If the data type is a category, each unique value will be identified and randomly 

assigned a colour. 

Step 3.2-121: To manually create the drillhole colour map, click the Add Colour map item, which 

will add a new row. Clicking the minus icon in the row will remove the row. If the data type is 

numeric, type numbers into the Property box. If the data type is category, type the values into 

the Property box. Then click the Colour box and select the colour. 

Step 3.2-132: After creating the colourmap, automatically or manually click the Save Colourmap 

button. 

Step 3.2-143: To load the drillholes select the drillholes in Explorer, right click and select Load. 

 

Step 3.2-42: To import drill holes data, go to Explorer panel and right click Drillholes branch and 

select Import. 
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Step 3.2-53: The following Add Drill Holes pop-up menu will appear.  Click the folder icon next 

to Collar File. 
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Step 3.2-64: Select the collar file, which is in .csv file format. 

 

Step 3.2-75: The first 5 rows of the file are listed. Select the correct matching columns for the 

Hole ID, X, Y, Z and depth parameters of the collar data. 
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Step 3.2-86: Repeat the same process for the survey file. Select the correct matching columns 

for the Hole ID, Depth, Dip and Azimuth parameters of survey data. Check the “Negative dip 

values represent downward direction” checkbox if this applies to your data. 

You can have more than one interval file. Click the plus and minus icons to adjust the number of 

interval files. 
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Step 3.2-97: Click the folder icon next to Interval Files to select the interval file. Select the 

correct matching columns for the Hole ID, From and to parameters of the interval data. Select 

“Value” for the columns that you want to import. If “Ignore” is selected for a column that column 

will not be imported. 
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Step 3.2-108: Once the collar, survey and interval files are added, click the Add DH to Project 

button. 
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Step 3.2-119: Drillholes will appear in the Explorer panel under the Drillholes branch. Right click 

the Drillholes and select the Drill Hole Colourmaps. 

 

Select the interval property and select the type of data as Numeric or Category. Click Auto 

Generate. If the data type is numeric, the minimum and maximum values will be found, and the 

data will be split into 10 equally sized groups; coloured from blue to red.  
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Step 3.2-20: If the data type is a category, each unique value will be identified and randomly 

assigned a colour. 

 

Step 3.2-121: To manually create the drillhole colour map, click the Add Colourmap item, which 

will add a new row. Clicking the minus icon in the row will remove the row. If the data type is 

numeric, type numbers into the Property box. If the data type is category, type the values into 

the Property box. Then click the Colour box and select the colour. 
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Step 3.2-132: After creating the colourmap, automatically or manually click the Save Colourmap 

button. 

 
 

Step 3.2-143: To load the drillholes select the drillholes in Explorer, right click and select Load. 
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3.2.4  Raster Files 

 

Step 3.2-154: GeoTiff files can be imported to HiveMap. They are limited to 16384 x 16384 

pixels. To import raster files, in the Explorer panel right click the Raster Files branch and select 

Import. 

Step 3.2-165: Right click the imported raster files and click load to display them on 3D View. 

Step 3.2-176: The raster file will appear as a georeferenced image in the 3D View. It will be at 0 

altitude. 

Step 3.2-187: Raster files can be draped to meshes. Right click the raster file and select Drape 

to Mesh. 

Step 3.2-198: On the Explorer panel everything becomes grayed except the mesh files. Click 

the mesh that you want to drape the raster file to. 

Step 3.2-9: The name of the mesh file will be displayed next to Raster Files. If the mesh is not 

loaded. Load the mesh and raster file. Raster files will be displayed on the mesh. 

 

 

 

 

 

Step 3.2-154: GeoTiff files can be imported to HiveMap. They are limited to 16384 x 16384 
pixels.To import raster files, in the Explorer panel right click the Raster Files branch and select 
Import. 
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Step 3.2-16: Right click the imported raster files and click load to display them on 3D View. 

 

Step 3.2-17: The raster file will appear as a georeferenced image in the 3D View. It will be at 0 

altitude. 
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Step 3.2-18: Raster files can be draped to meshes. Right click the raster file and select Drape 

to Mesh. 

 

Step 3.2-198: On the Explorer panel everything becomes grayed except the mesh files. Click 

the mesh that you want to drape the raster file to. 
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Step 3.2-29: The name of the mesh file will be displayed next to Raster Files. If the mesh is not 

loaded. Load the mesh and raster file. Raster files will be displayed on the mesh. 

 

 

3.3  3D View and View menu 

Loaded data are displayed in the 3D View panel. 

 

The Compass is located on the top right corner. It displays the camera orientation of the 3D 

View.  
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Using 3D View and View Menu Tools. 

An information bar is in the bottom part of the 3D View. When a mouse hovers over an object it 

displays the related info. 

 

View settings of the 3D View can be changed with the mouse and View menu. 

To rotate objects, right click on the mesh and a green spot will appear. This is the rotation axis 

which is the pivoting center of the image. Press the Ctrl key to rotate the camera, not the 

objects. 

 

Use the scroll wheel on the mouse to zoom in and out. Zoom direction can be adjusted in the 

settings. 

Use the middle mouse button (usually the scroll wheel) to pan the objects. 

View menu is located left side of the HiveMap window. View menu is used to adjust the camera 

of the 3D View and display settings of the objects in the 3D View. 

 

   
Perspective button switches between perspective and orthographic view. In the orthographic 

view a scale bar is displayed in the bottom right corner. 

 

 
 Fit to screen button moves the objects to the center and fits hem to the view. 

 

  
Direction buttons fit the objects to view and rotates the camera to the selected direction. 
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3.3.1 Mesh Colour 

Mesh colour can be changed to show different attributes. These include: 

 

Texture: If the mesh has a texture, it will display the texture. Usually, photogrammetry models 

are textured mesh files. 
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Texture (Inverse Colour): If the mesh has a texture, it will display the texture with inverse 

colour. This method sometimes can make some structures and features easier to notice. 

 
Vertice Colour: If the mesh has colour on its vertices, it will display these colour. When the 

point clouds converted to meshes each point becomes a vertex and the point colour is 

transferred to the vertex. 

 

Shade: If there is no texture or vertice colour, this the default view. The surface will be white 

and shaded according to its vertex normals. 
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Wireframe: This will show only the triangle edges. This can used to display the mesh geometry 

resolution and quality. 

 
 

Orientation: This will colourize the surfaces according to the vertex normals. This can be useful 

to find the joint facets. 
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Slope: This will colourize the surfaces according to the Dip of vertex normal. A Slope legend is 

also displayed. 

 

 
 

Aspect: This will colourize the surfaces according to the Dip Direction of vertex normal. An 

Aspect legend is also displayed. 
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Elevation: This will colourize the surfaces according to the elevation of the vertices. An 

elevation legend is also displayed. 
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3.3.2 Mesh View Aspect 

 

Meshes have front and back sides. On default both sides of the meshes are displayed. You can 

choose to view only one side. This can be important when displaying underground development 

or tunnels.  

 
 

 

 

Here is a back side culled mesh of a stope, with the inside of the stope visible. 
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Here is a front side culled mesh of a stope, with the outside of the stope visible. 

 

3.3.3 Mesh and Data Clipping 

The "Clip Mesh and Data" button displays a bounding box around the meshes and hide it if 
clicked again. When you click on this bounding box, the Properties panel will show buttons for 
clipping. 

 

The "Resize," "Rotate," and "Reposition" buttons provide controls to adjust the bounding box. 
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Bounding box also can be adjusted by using the two boxes which are located on the bottom 

south-west and top north-west corners. Clicking these boxes will display controls for adjustment. 
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Clicking Clip button will hide the mesh and data which is not inside the bounding box. Unclip 

button unhides the mesh and data. Reset button resets the bounding box. 
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3.3.4 Trace Visibility 

There are 2 Trace settings in the View Menu.  

Width slider adjusts the Trace width. 

 

If the "Always Visible" checkbox is checked, the meshes will not obscure the traces. If 

unchecked, parts of the trace that are behind the mesh will become invisible.
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3.3.5 Disc Visibility 

There are 4 Disc settings in the View Menu. 

The Thickness slider adjusts the thickness of the discs. 
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The Opacity slider adjusts the transparency of the discs. 

  

If the Constant Size check box is checked all the discs are displayed with the same diameter 

relative to the screen. This diameter can be adjusted with the Constant Size slider. 
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3.3.6 Drillhole Visibility 

There are 3 Drillhole settings in the View Menu. 

Display Drillholes checkbox hides or unhides the Drillholes. 

The Width slider adjusts the drillhole diameter. 
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The "Toggle Drillhole Attributes" button allows you to switch between different attributes and 

interval files. The first text below this button displays the currently used interval file, while the 

second text shows the attribute name.

 
 

 

 

 



 

 
Table of Contents 

 
HiveMap User Manual (v2 20250424)                                                                                            Page 85 of 160 

3.4  Mapping 

The Mapping menu has 4 tools for mapping: Tracing, Measurement Orientation Tool, Stereonet, 

and Joint Sets. 

 

 

3.4.1  Tracing 

The tracing tool group enables users to trace the geological structures. 

 
Draw button opens the list of structures. 

 
Selecting a structure starts the tracing process. During this process other tools remain disabled.  
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Clicking on Stop, stops the process and will allow for other tools to be used. 

 
Use your left mouse start tracing the structure on the mesh. You can do single clicks or hold 

down the left mouse button. 

 

 
 

The "Drape Trace onto Surface" option drapes the trace onto the surface. If the "User View" 

checkbox is checked, the draping direction can be adjusted with the mouse. If the "Z Axis" 

checkbox is selected, the trace will be draped vertically. 

 

With the draping feature, you can capture a mesh shape with just two mouse clicks. 
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Clicking the ‘Undo button’ or backspace key will delete the last node. Clicking on the ‘Redo 

button’ brings back the removed nodes. 

The ‘Undo last click button’ will delete all the nodes which have been created with a single click. 

The ‘Redo last click ‘brings back all of the removed nodes that had been created with single 

clicks. 
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While tracing, you can split traces to follow structures that are not continuous. 

 
 

After finishing tracing click on the ‘Stop button’ to end the process. 

 
 

Instead of clicking on the Stop button, you can press the ‘Enter Key’ or click with the right and 

left mouse buttons simultaneously. This will end and restart tracing for the same structure. 

 

The new trace file is displayed on the Explorer panel under the Traces branch. Trace files are 

saved to the Traces folder inside the Project folder. 
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The Trace Settings menu has 4 options: 

1. Don’t show menu when disc/cones clicked: When the trace discs and cones are clicked 

the trace menu is displayed. If this option is unchecked, only clicking the trace itself will 

open the trace menu. 

2. Show menu after creating trace: If this option is checked, after finishing tracing, the trace 

menu will be displayed automatically. 

3. Create disc after tracing: This will automatically create the trace disc/cone after the 

tracing is finished. 

4. Trace simplification tolerance: The simplification process leverages the Ramer-Douglas-

Peucker algorithm to decrease the number of points, guided by the Tolerance 

parameter. 

 

  
 

The "Trace Filter" button opens the trace filtering menu, allowing users to filter the loaded traces 

based on structure, trace author, and mesh. 

 

https://en.wikipedia.org/wiki/Ramer%E2%80%93Douglas%E2%80%93Peucker_algorithm
https://en.wikipedia.org/wiki/Ramer%E2%80%93Douglas%E2%80%93Peucker_algorithm
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The "Undo" button reverses the most recent trace deletion. Deleted traces are stored in the 

Recycle Bin within the project folder. 

 

 
 

To edit the trace file, left click the trace in the 3D View menu. Alternatively, right click the trace 

on the Explorer panel and then the Edit Trace on the right click menu. 
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The Trace Menu is displayed, and the nodes of the trace polyline/polygon becomes visible. 
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Click Add Point button and then click the trace line. 

 

 
 

 

A new node will be added where the line is clicked.  
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Click one of the white nodes. The node will become red, and on the Trace Menu, the Delete 

Point button will become visible. Click this button to delete the selected red node. 

 

 
 

Click the mesh and the red node will move to the clicked position on the mesh. 

 
 

Click the first or last node, which will be in purple. The node will turn red, and the "Delete Point" 
and "Continue Tracing" buttons will appear in the Trace Menu. Click "Continue Tracing" to close 
the Trace Menu and hide the nodes, allowing tracing to resume from the selected node. 
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An orientation can be calculated for each trace line by selecting the trace and pressing the 

Calculate DD/Dip of Trace. 
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If it is a linear structure, you can fit a cone. This may be done by selecting the Lineation trace 

option. 

 

 
 

If it is a folded structure, you can add discs along the trace to capture an orientation change.  

 
 

Duplicate trace button duplicates the trace as a different structure. For example, if a fault is a 

contact, after tracing the fault it can be duplicated as contact. 
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"Copy Attributes from Other Trace" will copy the form data from another trace. After clicking this 

button, select the source trace that corresponds to the same type of structure. 
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In the Explorer panel, the right-click menu includes options to Zoom, Hide, Unhide, Edit, and 

Delete traces.  

  
 

In the Explorer panel, right click menu for the Traces branch includes the Import button, which 

will display .csv import menu. 
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Click the folder button to select the .csv file.  

 
 

Select the structure type that the polyline is going to represent and adjust the “”skip lines”, 

“seperator” and “polyline seperator” parameters to correctly parse the .csv file.  
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Select the matching columns for x, y and z. Click import to create the trace file. 
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3.4.2  Orientation Measurement Tool 

The orientation measurement tool enables users to measure orientation of the geological 

structures. 

To begin the process, navigate to the Mapping tab on the ribbon and click the "Measure" button 

in the Orientation Measurement group.

 

The number of sampling points can be adjusted using the Points slider. Increasing the number 

of sampling points will provide a more accurate orientation measurement. The minimum value is 

3, and the maximum value is 12. 

 

 
 

Sampling points can be placed on the structure traces and facets: 

 

1. Identify a joint trace and begin placing sampling points on it using your left mouse 

button. A disc will form once you’ve placed the number of points specified by the point 

slider. The orientation of the disc is determined by calculating the best fitting plane. The 

disc’s location and size are based on the two points that are furthest apart. 
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2. Locate a facet of a joint on the mesh. Use your left mouse button to place sampling 

points on the facet surface. A disc will form once you’ve placed the number of points 

specified by the point slider. 

 

 
 

While placing sampling points you can press the backspace key or click the Undo button to 

undo the last sampling point. 

 

 
If you have flat facets to map, you can adjust the point slider to minimum and create discs 

quickly by just placing 3 points for each of them. 

 

Alternatively, you can keep the Points slider at maximum and press the enter key to create discs 

by using variable number of points for each joint. If you have facets and traces with rough, 

wavey surfaces you need to increase the number of sampling points to get the correct average 

orientation of the structure. 

 

After you’ve finished mapping, click the Stop button. 
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Your disc data will be saved to OrientationData.csv file in the Project/OrientationData folder. If 

there is any unsaved data, a * sign is displayed next to the file name. Click the Save or Stop 

button to save data to the file and remove the * sign. 

 

 
 

 
 

If you want to save into a different file, right click the Discs branch in the Explorer panel and 

click add new file button. 
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Type the name of the file and click the Create File button. 

 
Right click the file and click the Active File. Next to the filename a √ symbol will be displayed to 

mark the file as active file. The new discs that are created will be saved into this active file. 
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To import orientation data from a .csv file, right click the Discs branch and click the Import 

button. 
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Click the folder button to select the .csv file.  
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Adjust the “skip lines” and “seperator” parameters to correctly parse the .csv file.  

 

 
 

Select the matching columns for dip, dip direction, joint set, x, y, z, diameter, etc. Click import to 

create the new orientation data file. 
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Left click a disc to access the disc properties. Diameter can be modified by editing the diameter 

textbox or slider. 

 
 

Orientation can be modified with two methods: 

1. Edit the Dip Direction and Dip text boxes or use the mouse scroll after clicking these text 

boxes.  

2. Click the rotate  button. For each axis, 3 circles on the disc will be displayed. Click 

one of these circles and rotate the disc by dragging the mouse. Click the reset button  

to reset the rotation change. 
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To change the location of the disc, click the move button . For each axis and each axis 

combination, 3 arrows and 3 planes will be displayed on the disc, respectively. Click one of 

these arrows or planes and move the disc by dragging the mouse. Click the reset button  

to reset the location change. 
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A disc can be deleted in one of three ways. Select the disc and: 

 

1. Press the Delete key. 

2. Click the Delete button on the ribbon menu.  

3. Click the Delete button on the Properties panel. 

 

 
 

Click the Delete button on the Properties panel. 

 

 
 

To remove all of the discs, click the Clear button on the ribbon menu. 
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The Colourize function is used to highlight the mesh triangles with a specific orientation.  

 

 
 

Click the "Colourize" button, and a menu with three sliders will appear in the 3D View menu. 

Use these sliders to set the Dip, Dip Direction, and Variance. The slider values are displayed in 

the 3D view information bar. 

Click the colour button to change the highlighting color. 

If you click a disc, the sliders will automatically adjust to match the disc's orientation. 
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Check "Filter by Diameter" to filter the discs based on their diameters. 

 

 
 

 

 

3.4.2.1 Auto Facet Mapping 

The Auto Facet Mapping algorithm searches for facets and creates discs for each facet that it 

detects. This algorithm works with cell polygons (refer to Section 3.4.5).  

 

Click the Auto FM button. A menu will be displayed with these options: 

 

● Cell list: Select the cells where the facets will be searched. 

● Angle variance: Each vertex of the mesh has a normal. Vertices from the same facet will 

be oriented to the same direction with some variability due to facet surface roughness 

and waviness. Using the variance parameter algorithm, it decides to add or remove 

vertices to the facets.  

● Minimum number of vertices: If a facet has less vertices than this parameter, it will not 

be included. 

● Maximum Amplitude: A vertex will be part of the facet if the distance from the facet plane 

less than this value.   

● Simplify: It is the ratio of vertices that will be used in the algorithm. When the parameter 

is 1 all the vertices will be used. This will cause the algorithm to run longer.  

● Show Facets: After running the algorithm discs will be generated on the facets. if Show 

Facets is checked, vertices will be coloured. If they are from the same facets, they will 

have the same colors. Each facet will have a random colour. 
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3.4.3  Stereonet 

 

Poles of discs, cones, joint sets, and kinematic analysis elements such as friction cone, daylight 

area, etc. are displayed on the Stereonet. The Save and Stereonet Menu button is in the bottom 

right corner. Save button saves the stereonet to Stereonet.jpg file in the project folder. 

 

 
 

Show Poles option displays disc poles as dots and cones as triangles. 
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 Show Contours displays the density of disc and cones. 

 

 
 

The grid can be removed or selected as polar or equatorial. The projection is set to equal angle, 

as equal area is not yet supported. 
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Data on the Stereonet can be filtered using cells (Section 3.4.5). If no cell is selected, all the 
data will be shown. 

 
 

 

 

3.4.4 Joint Sets 

3.4.4.1 Clustering 

In the Joint Sets panel, joint sets can be determined using a Fuzzy K-Mean algorithm, either 

automatically or manually. 

 

To find the joint sets automatically, check the Auto box.  
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Auto method algorithm requires 2 parameters: 

1. Number of joints: This should be estimated by using the stereonet and interpreting the 

rock face. 

2. Fuzziness: If fuzziness is 0, the algorithm will assign every joint to a joint set. If there are 

random joints which are not close to any joint set center, they should not be assigned to 

a joint set. This can be adjusted with increasing the fuzziness parameter. The higher the 

fuzziness is, the less dispersed the joint sets will become. 

 

 
 

After running the algorithm, joints are separated into sets and each joint pole on the stereonet, 

and the disc on the 3D view, are colourized into their joint set colour.  

 

If the Colourize Meshes button is clicked or Auto box next to it is checked, the triangles, which 

have the same orientation as the joint sets, are colourized too. 
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Joint sets are listed in the Joint Sets list.  

Each joint set has a slider, a check box, and a button in the joint set colour.  

• The slider changes the opacity of the joint set discs.  

• The checkbox hides and unhides the discs of the joint set.  

• The button opens the joint set menu. 

 
 

To determine the joint sets manually, check the Manual box. This will disable the Fuzziness 

slider and the button text will change to “Assign Joints to Joint Sets”.  
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Enter the number of joint sets. 

 

Click the Assign Joints to Joint Sets button. 

 

On the joint set list, click the JS#1 button to open Joint Set 1 menu.  
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Click to select the Joint Set on the Stereonet. Adjust the Dip Direction Deviation and Dip 

Deviation values in the form. Then, click on the Stereonet and drag the mouse to reposition the 

Joint Set 1 window on the Stereonet. 
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Click “X” on the top right corner of the menu and click the Save changes and close button. 

 
 

Click Assign Joints to Joint Sets button. All the joints inside Joint Set 1 window will be assigned 

to the Joint Set 1.  
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Repeat this process for the other joint sets. 

 

 

3.4.4.2 Joint Set Spacing 

 

To calculate joint set spacing for a joint set open the joint set menu of that joint set. 

 

The Joint Spacing algorithm measures the distance between each disc pair, and if they intersect 

when they are projected in the joint set orientation. 

 

• Display measurements as lines: This will display green or red lines in the disc center. If 

there is a measurement, line will be green. Users can validate the algorithm by checking 

the measurements. 
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• Max. spacing: If the distance between two discs is larger than the maximum spacing 

value, it will be ignored. 

• Disc size: This is the disc diameter scale during the calculation. If the disc size 

parameter is 1, the disc diameters stay same during the calculation. 2 will double the 

disc diameters. If the discs are mapped smaller than they should be, the disc diameters 

can be increased to ensure that there is measurement between these discs.  

• Distribution: Lognormal or Negative Exponential can be selected. This will be displayed 

on the histogram. 

 
 

Click the Calculate Joint Spacing button to run the algorithm.  

 

A histogram will be created with the selected distribution.  

 

Mean, standard deviation, min, max values will be calculated. Raw data are saved in the 

JointSets folder in the Project folder as .csv file. 
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3.4.4.3 Joint Set Persistence 

Click Calculate Joint Persistence to calculate disc size statistics of the joint set. 

  

A histogram will be created with the selected distribution. 

 
 

3.4.5 Cell Mapping 

 

With the Cell Mapping tool users can draw polygons which can be used to: 

1. Do geotechnical cell mapping. 

2. Separate the geological domains. 

3. Split rock faces according to slope direction for kinematic analysis. 

 

To create a cell polygon, select Draw. 

 

 
 

Use your left mouse and do single clicks to draw polygon.  
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Clicking Undo button or backspace key will delete the last node. Redo button brings back the 

removed nodes. 

 
 

 
 

Click the Stop button to finish drawing. 

 

 
 

The new cell file is displayed on the Explorer panel under the Cells branch. Cell files are saved 

to the Cells folder inside project folder. 
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Assign button assigns joints to the cells. 

 

 
 

Discs from the same cells are colored identically, while discs that are not in any cell are 

displayed in gray. 
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Cells are also listed on the stereonet, joint set menu and kinematic analysis menu. Discs can be 

filtered by selecting a cell in the Filter by Cell drop down menu. 
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The "Undo" button restores the most recently deleted cell. Deleted cells are stored in the 

Recycle Bin folder within the project folder. 
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To edit a polygon, left click the cell in the 3D View menu. Alternatively, right click the cell on the 

Explorer panel and then the Edit Trace on the Right Click menu. 
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When the Cell Mapping Menu is displayed, and the nodes of the polygon becomes visible. 

 

 
 

Click the Add Point button and then click the polygon. 
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A new node will be added where the polygon is clicked. 

 
 

Click one of the white nodes. The node will become red, and, on the menu, the Delete Point 

button will become visible. Click this button to delete the selected red node. 
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After selecting node, click the mesh and the red node will move to the clicked position on the 

mesh. 

 

 
 

Click the first or last node, which will be purple. The node will turn red, and the "Delete Point" 

and "Continue Tracing" buttons will appear in the menu. Click "Continue Tracing" to close the 

trace menu and hide the nodes, allowing tracing to resume from the selected node. 
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3.4.6  Ruler Tool 

 

The Ruler tool can be used to measure length, vertical length, horizontal length, trend, and 

plunge between two points on the mesh.  

 

 
 

When this tool is activated, a line will be displayed on the screen. The endpoint that is clicked 

becomes active.  
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When the user clicks a point on the mesh the active endpoint will be placed to that point. 

Measurements will be displayed in the Console panel. 
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3.5  Kinematic Analysis 

After completing mapping - planar sliding, wedge sliding, flexural toppling, and direct toppling 

kinematic analysis can be conducted. 

 

 
Analysis can be done for all the mapping data or data can be filtered using the Filter by Cell tool. 

 
 
Wedge sliding and direct toppling might happen when there are wedge shaped blocks. Wedge 

shaped blocks are created by the intersection of joints. To find the intersections between joints 

click Find Intersection button. 

 
 

Cones will be created along the disc intersections. 
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Remove intersections button deletes the intersection cones. 

 

 
 
Slope plane, friction cones, daylight envelope and lateral limits can be displayed on the 

stereonet. 

 

 
 

Planar sliding: For a joint to cause a planar failure, it must be within the daylight envelope, 

have a dip angle greater than the friction angle (outside the friction cone), and be within the 

lateral limit. This area on the stereonet is displayed in red. Discs within this area are colored red, 

while the remaining discs are colored green. 
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Wedge sliding: Once the disc intersections are calculated, this analysis can be run. If a joint 

intersection is going to cause a wedge slide, it should be inside the planar friction cone and it 

should be outside of the slope plane. This area on stereonet displayed with red colour. Cones 

which are inside this area are coloured in red. 

 

There is a secondary area where the wedge blocks slide on one of their sides. This area is 

outside of the slope plane, outside of the planar friction cone and inside of the planar friction 

plane. This area on stereonet displayed with yellow colour. Cones which are inside this area are 

coloured yellow. 

 

The rest of the cones are coloured green. 
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Flexural toppling: If a joint is going to cause a flexural toppling, it should be outside of slip limit 

(slope dip-friction angle) plane and it should be in the lateral limit. This area on stereonet 

displayed with red colour. Discs which are inside this area are coloured red and rest of the discs 

are coloured green. 

 
Direct toppling: Once the disc intersections are calculated, this analysis can be run. If a joint 

intersection is going to cause a direct toppling, it should be inside the slope dip cone, it should 

be inside the lateral limits and dip into the slope. This area on stereonet displayed with red 

colour. Cones which are inside this area are coloured red. 

 

There is a secondary area where the wedge blocks topple at an oblique angle. This area is 

inside of the friction cone, outside of the lateral limits and dipping into the slope. This area on 

stereonet displayed with yellow colour. Cones which are inside this area are coloured yellow. 

 

The rest of the cones are coloured green. 
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After running analysis Export Results button is displayed. Click this button to export results into 

KinematicAnalysis folder. An image of the stereonet and a .csv file will be saved. 

 

 
 

 

 

 

 

 

 

 

 

 



 

 
Table of Contents 

 
HiveMap User Manual (v2 20250424)                                                                                            Page 140 of 160 

3.6  Sampling 

The Sampling tool may be used to support chip sample mapping. 

 

Click Draw button. 

 

 
 

Click the start and end points of chip sampling intervals on the mesh. 

 
 

 

Use Undo and Redo buttons to undo and redo last node while drawing. 
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Click Stop after finishing. 

 
 

 

 

In the explorer panel under the Sampling branch, the sampling files are listed. 

 

To edit the sampling data right click and select Edit Trace or left click the sampling polyline in 

the 3D View. 

 

The Sampling Menu will be displayed, and the nodes of the trace polyline/polygon becomes 

visible. 
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Each segment of polyline represents a sample. Clicking a sample scrolls the form to that 

sample. 

 

Sample ID fields on the form can be automatically filled. Type the Prefix and the sample number 

of the first sample. Click Fill Sample ID’s. 
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Click one of the white nodes. Node will become red and, on the menu, Delete Point button will 

become visible. Click this button to delete the selected red node. 

 

  
 

Click the mesh and the red node will move to the clicked position on the mesh. 
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Click the first or last node which is purple in colour. The node will become red, and, on the 

menu, Delete Point button and Continue Tracing button will become visible. Click continue 

tracing. This will close the Sampling Menu and hide the nodes and tracing will continue from the 

selected node. 

 

 
 

In the explorer panel, the right click menu includes options to zoom to a trace and hide/unhide 

traces. Besides editing a trace, multiple traces can be also deleted.  
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Undo button undeletes the latest sampling. Deleted sampling files are stored in the Recycle Bin 

folder within the project folder. 

 

 
 

Convert button converts sampling trace to a drillhole and saves into SamplingDH folder as .csv 

files. 
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3.7 Tools 

The Tools menu includes various functionalities. 

 

 
 

Template Editor: Trace structures and their attributes, cell mapping attributes, and sample 

attributes are customized in Template Editor.  
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Structures are listed in the left panel. Click up and down buttons, which are placed next to each 

structure button, to change the order of the structures. Click Add button to add new structure. 

 

 
 

Click a structure to display the structure form on the right-side panel. On top of the panel, name 

and colour of the structure item can be changed. Click Add Text Box button to add a new text 

box to form and click Add Drop Down to add a new drop down list to the form. Delete button, 

which is located on the bottom of the panel, removes the structure. 
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Click the up and down buttons to change order of the items on the form. Click – button to delete 

an item. Click Add Item button to add a drop-down item to drop down list. Click up and down 

buttons to change order of the list items and click the – button to delete them. Click the square 

box to change the colour of list item. 

 
 

Export Traces as .csv Files:  For each structure type a .csv file is generated. Polyline/polygon 

and attributes of the related traces are saved in these .csv files, which are located in 

ExportedTraceData folder of the project. 

Export Traces as .dxf Files: Polylines/polygons of each trace file are saved as a seperate .dxf 

file in the ExportedTraceData folder of the project. 

Add Discs to Traces: This will add a disc to traces which does not have a disc. 

Export Trace Discs: All trace discs are saved into TraceOrientationData.csv in 

ExportedTraceData folder in the project folder. 

Export Discs as .obj File: Discs are saved as a mesh file in .obj file format. This file can be 

found in the project folder. 

Flight Mode: When the flight mode is activated, the camera in the 3D View can be moved with 

keyboard. Control keys are listed in the drop-down menu. This may be useful for capturing 

videos for use in presentations. 
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Mesh Transformation: Mesh Transformation menu lists the .obj mesh files of the project.  

• Flip y-z, x-y axis: Some software export meshes with different axis for vertical or 

horizontal axis. These files can be fixed with this tool. 

• Flip triangles: This changes which side of the mesh is front, and which is side is back. 

• Translate Mesh: Moves the meshes by adding values in the x,y,z boxes. 

• Import new mesh files: Imports the processed mesh files. 

• Delete proceeds mesh files: Processed mesh files are moved to the Recycle Bin folders. 
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Georeference: This tool georeferences mesh files, such as those from iPhone/iPad scans, 

which use local coordinates and have an incorrect northing direction. However, their scale and 

vertical orientation are accurate.  

For georeferencing 2 survey points, or 1 survey point and the north direction is specified: 

Click the Place Survey Point #1 button.  

 

Click the survey point on the mesh, this will create a red sphere on that point. 

Click Survey Point [Stop] button. 
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Enter the Survey Point #1 coordinates. 

 

If you have 2 survey points, select the SP1&SP2 checkbox. 

 

Repeat the same process for the survey point 2. 

If you have 1 survey point and you know the north direction, select the SP1&North correction 

checkbox, and enter the north correction which is the difference between the azimuth of the 

mesh and north. 
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Click the Georeference button.  

If the mesh is mapped before it is georeferenced, the traces and discs will be not georeferenced 

either. If the Update trace files of the mesh and Update discs of selected mesh are selected, 

these files will also be georeferenced along the mesh. 

 

 

Export Dip/DD of Meshes: It collects the following data from the meshes: 

• Triangle centers: Orientation of the mesh triangles and position of the triangle center. 

• Vertices: Orientation of the mesh vertices and position of the vertices. 

• Inside triangles: Orientation of the mesh triangles and the 3 positions between triangle 

center and triangle corners. 

• Average of each mesh: It finds the best fitting plane for the vertices of the mesh. This 

planes orientation and center. 

Results are exported to the Exported_DD_Dip.csv file in the project folder. 
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Projection of Traces: This tool changes the coordinates system of the georeferenced traces to 

another coordinate system. 
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3.8  Networking and Collaborative Mapping 

In HiveMap users can collaborate remotely. They can do virtual site visits where they can map 

virtual outcrops together. They can also do audits where they can review and edit the mapping.  

During online meetings, screens are not shared. Mouse location and real-time mapping data are 

shared.  

Each user should have the same mesh files, drill hole data and raster files before the meeting. 

All the participants should enter the same Room Name and Room Password to meet in the 

same room. 

Display Name should be unique to each user.   

Click the Join button to start/join the online meeting. Participants are listed in the right side of 

the menu, under Networking.  

 

During the meeting in 3D View, each participant’s mouse cursor is displayed with their display 

name.  
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All tracing data that is created during the meeting is shared between the participants in real-

time. The Sync button syncs the traces which are created before the meeting. 

Click the Leave button or close the HiveMap to leave the meeting. 

3.9 Tablet Mode 

By clicking the Switch button on the top left corner, you can switch between tablet mode and 

desktop mode. Tablet mode changes scale of the user interface to make menu items larger so 

the users can easily use their fingers instead of a mouse to interact with them. The scale for 

tablet mode can be adjusted in the Settings Menu. The layout is switched to the Tablet mode. 

 

The View menu is hidden and can be displayed by clicking the View Menu button on the lower 

left corner. 

 

Single finger behaves like left mouse button. In the Explorer panel holding your finger longer on 

the screen will open the right click menu. In the 3D View panel, 2 fingers are used for zooming 

in/out and panning. 3 fingers are used for rotation.  
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3.10 Settings 

To open the settings menu, go to the Help menu and click the Settings button or click the 

settings button on the top right corner of HiveMap windows.  

 

 
 

 

 

 

Username: The username is included in the trace file names and in the author section of the 

files. If a trace file is edited, the username of the editor is saved in the file. In orientation data 

files, the authors username is also saved for each disc.  

Main folder: All HiveMap project folders will be created in this folder. To update the main folder 

location, click on Select Main Folder. The Select Folder browse window will pop up. Select a 

folder location where all HiveMap files can be saved. 
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Inverse mouse scroll: Mouse scroll direction for zooming in 3D View changes. 

Sharper text and buttons: On default it should be checked. If there is performance issue with 

your computer, this can be unchecked to improve it. 

Cap frame rate at 30fps: On default it should be unchecked. If there is performance issue with 

your computer, this can be checked to improve it. 

Menu scale (%): Default value is 100%. Increasing this value will increase the user interface 

elements and decreasing it will make them smaller. 

Menu scale for tablet mode(%): User interface scale during the tablet mode. 

Camera clipping plane near: Default value is 1. Camera cannot see anything closer than this 

distance. Decreasing this value below 1 is not suggested as it might decrease the accuracy of 

the mouse. 

Camera clipping plane far: Camera cannot see anything further than this distance. 

Select background colour: 3D View background is adjusted here. 
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3.11  Help 

Within the Help section, users can access the user manual, the settings, about details, license 

ID, the feature request, and the IT support ticket forms. 

 

 
 

The Manual button opens the link of the .pdf manual file.  

 

The Debug can be accessed by users when troubleshooting issues with Help Desk support. 

 

The Settings button opens the settings menu. 

 

The About button opens the HiveMap about menu. HiveMap version number is displayed here. 

 

License button opens License menu (link). 

 

The Feature Request and Support Request buttons open the forms to contact HiveMap support. 
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4 Support 

4.1  Reporting Issues 

If users encounter any technical issues with HiveMap, please submit an IT Support Request 

Form.  Help Desk support will follow up with clients for each ticket submission.  

4.2 Requesting Product Feature Enhancements 

If users would like to request a product feature enhancement, please complete the Product 

Feature Request Form.  Help Desk support will log each product feature request submission, 

and these will be reviewed periodically as product development progresses. 

4.3  Other Inquiries  

For any sales and or general inquiries (not tech / help desk related), please email 

Inquiries@hivemap3d.com.  

4.4  System Requirements 

To run HiveMap software, the minimum system requirements for Desktop are as follows: 

● Operating System: Windows 10 / Windows 11 
● Memory: 8 GB (Minimum), 16 GB (Recommended) 

4.5  Resources 

Users can access HiveMap related resources on the website Resources page:  

hivemap3d.com/resources  

Resources available include: 

● HiveMap User Manual 

● HiveMap Training Data.zip files (contains 3 zipped sub-folders) 

○ HiveMap_JointSetAnalysis 

○ HiveMap_Training_Initial 

○ HiveMap_Training_Interpreted 

● Privacy policy  

● End User Licensing Agreement (EULA) 

 

https://hivemap3dsa.ebforms.com/6343937109524480
https://hivemap3dsa.ebforms.com/6343937109524480
https://hivemap3dsa.ebforms.com/6006335063982080
https://hivemap3dsa.ebforms.com/6006335063982080
mailto:Inquiries@hivemap3d.com
http://hivemap3d.com/resources
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4.6  Software Updates 

When there is a new update for HiveMap, users can use Microsoft Store to update HiveMap. If 

“App Updates” are on in the settings menu of Microsoft Store, updates will be done 

automatically. If it is “Off” users can go to the “Downloads” tab and update HiveMap.   

 

 

 

 

 

 


